
 

 

 

 

 

 

 

Microsoft Excel  

Over The Wall 
THE BUSINESS POWER OF SPREADSHEETS 

 

 
 

by  JOSEPH CLARK 



 

COPYRIGHT NOTICE 

 

This textbook is entirely the work of Joseph W. Clark, and I 

reserve all my rights under copyright law.  You may view the 

book online in PDF form, and print it out for personal, 

individual use.  You may not distribute the book in print, by e-

mail, or on disk to more than one person at a time, but you 

may tell others about the book and direct them to my website, 

http://www.joeclark.net. 

 

The book may not be used for commercial purposes.  You may 

not distribute the book in exchange for money.  If you are 

interested in purchasing the book in print or electronic form, or 

using it in your teaching, please contact me by e-mail at 

opportunity@joeclark.net. 

 

I hope you find this e-book useful.  Please contact me with any 

questions or comments. 

 

 



TABLE OF CONTENTS  

INTRODUCTION ................................................................ 6 

CHAPTER 1: WHAT IS A SPREADSHEET? ..................... 7 

What is a spreadsheet? .................................................................................... 7 

A basic example ............................................................................................... 7 

Summary .......................................................................................................... 9 

Exercises ......................................................................................................... 10 

MODELING LESSON 1 .................................................... 12 
Introducing Models ..................................................................................... 12 
Starting your Modeling Career ................................................................... 13 
Exercise ....................................................................................................... 15 

CHAPTER 2:  FORMULAS AND FUNCTIONS ............... 16 

Excel formulas ................................................................................................ 16 

Example: Employee Time Table .................................................................. 17 

Saving time with Fill ...................................................................................... 18 

A couple of basic functions (SUM, AVERAGE) ......................................... 19 

Putting formulas and functions together ..................................................... 21 

Summary ........................................................................................................ 22 

Exercises ......................................................................................................... 23 

MODELING LESSON 2 .................................................... 24 
Jinôs Golden Taxi Company ....................................................................... 24 
Exercises ..................................................................................................... 28 
Johnny Driver ............................................................................................. 29 

CHAPTER 3:  KEEPING TRACK OF YOUR CELLS ....... 30 

Excel Organization ........................................................................................ 30 

Everythingôs relative ..................................................................................... 30 

Absolute certainty .......................................................................................... 32 



Naming cells and ranges ................................................................................ 33 

Using mixed row and column references ..................................................... 34 

In case you get confused ................................................................................ 36 

Summary ........................................................................................................ 37 

Exercises ......................................................................................................... 37 

MODELING LESSON 3 .................................................... 39 
Manager Bing of Haerbin Refrigerators ..................................................... 39 
Exercises ..................................................................................................... 42 
Heilongjiang Wholesalers, Ltd. .................................................................. 42 

CHAPTER 4:  CHARTS AND GRAPHICS ....................... 44 

Using graphics to make your point............................................................... 44 

Introducing Excel charts ............................................................................... 44 

Calling on the Wizard ................................................................................... 46 

Source Data, Chart Options, and Location ................................................. 47 

Chart style ...................................................................................................... 49 

Adding other graphics and WordArt  ........................................................... 50 

Summary ........................................................................................................ 51 

Exercises ......................................................................................................... 51 

MODELING LESSON 4 .................................................... 53 
Beach City Beer Makers ............................................................................. 53 
Enough Math, Letôs Build a Model ............................................................ 54 
Integrating Charts into the Model ............................................................... 55 
Exercises ..................................................................................................... 59 
Andyôs American Pub and Club ................................................................. 60 

CHAPTER 5:  IF FUNCTIONS AND LOGIC IN EXCEL ... 63 

Logical tests in Excel ..................................................................................... 63 

Introducing the IF function  .......................................................................... 64 

Easier ways to enter functions ...................................................................... 65 

CountIF and SumIF ...................................................................................... 67 

MAX and MI N ............................................................................................... 68 



Making cell formats conditional ................................................................... 69 

Complex tests and nested Ifs ......................................................................... 70 

Summary ........................................................................................................ 72 

Exercises ......................................................................................................... 72 

MODELING LESSON 5 .................................................... 74 
Professor Zhou Submits his Grades ............................................................ 74 
The Final Grade, Logically ......................................................................... 75 
Finding letter grades with VLOOKUP ....................................................... 77 
Exercises ..................................................................................................... 78 
Office of Admissions, China Global Business College .............................. 79 

CHAPTER 6:  NO PROBLEM TOO DIFFICULT FOR 
SOLVER ........................................................................... 82 

Whatôs your goal? .......................................................................................... 82 

Preparing to be Solved .................................................................................. 84 

The power of Solver ....................................................................................... 85 

Summary ........................................................................................................ 89 

Exercises ......................................................................................................... 89 

MODELING LESSON 6 .................................................... 91 
Cathay Dragon Airlines .............................................................................. 91 
Results of Market Research ........................................................................ 91 
The First Simulation ................................................................................... 92 
Simulate! ..................................................................................................... 94 
Solving the Model ....................................................................................... 95 
Exercises ..................................................................................................... 96 
Hotshot Sales Agency, Ltd.......................................................................... 96 

EPILOGUE ....................................................................... 98 

APPENDIX A: GLOSSARY OF TERMS .......................... 99 

INDEX ............................................................................. 100 
 

 



 

 

 

Introduction 
 

The Great Wall of China is long, tall, and made of stone.  To 

one standing in front of it, there seems no way through.  It 

appears unconquerable.  But with the tools to climb atop the 

wall, one can see a vast new landscape and have complete 

freedom to move in an entirely new country. 

 

My view is that business computing tools are somewhat 

similar.  To an outsider, a glossy business magazine appears 

to be the work of magicians, with its professional charts, 

graphs, and numerical analysis.  Learning a tool like Microsoft 

Excel seems so difficult that many convince themselves they 

cannot use it.  But those who persist and learn a few basic 

tools soon find themselves on top of this Wall, with 360 

degrees of freedom, and soon the only question they have is 

òWhich way should I go next?ó 

 

This book aims to give the reader an understanding of the 

basic tools for using Microsoft Excel and other, similar 

spreadsheet software.  It differs from other books, in that it is 

written by an MBA and a teacher of business students, not by 

a computer scientist.  It focuses on areas of special 

importance to businesspeople, such as: 

¶ Organizing worksheets so others can understand them 

¶ Designing charts and graphs to best convey a message 

¶ Building spreadsheets that are easy to modify or re-use 

 

Furthermore, this book is written in English as clearly as 

possible, for use by non-native English speakers and for easy 

translation.  Spreadsheets, numbers, and graphics are a 

universal language of businesspeople from all nations, and I 

donõt want my native dialect to be a barrier to readersõ 

understanding. 



 

 

 

CHAPTER 1: What is a 

spreadsheet? 

What is a spreadsheet? 

A spreadsheet is a piece of software that organizes 

information in two dimensions and shows the relationships 

between numbers.  Spreadsheets were the first popular 

application of personal computers in the 1970s and remain 

one of the most important tools of todayõs businesspeople.   

 

The most popular spreadsheets, like Microsoft Excel, allow you 

to place text, numbers, graphics, and other items into a grid of 

rows and columns.  You can also insert dynamic calculations.  

These resemble mathematical formulas that use other data in 

the spreadsheet as inputs.  By changing those inputs, one can 

see how their results would change.  

 

A basic example 

If you have a computer with Microsoft Excel, start Excel now.  

Excel is part of the Microsoft Office package (also including 

Word, Access, and other software) and you can probably find it 

in your Windows Start Menu. 

 



 
The main application window of Microsoft Excel 

 

Notice the horizontal rows, identified by numbers on the left 

side of the window, and several vertical columns, identified by 

letters near the top.  Each of the small boxes at the 

intersection of a row and column is called a cell, and each cell 

can contain a piece of information. 

 

The address of a cell is its column letter and row number. For 

example, òA1ó is the cell at the top left and òB1ó is the cell to 

the right of it.  Click now in cell A1, type the word òincome ó, 

and press Enter.  Continue and enter the data shown in the 

illustration in cells A2, A3, A4, and B1 through B3. 

 

 
The setupé 

 

In cell B4, you will create your first dynamic calculation, a 

formula which adds the three numbers.  Click on that cell and 

type ò=B1+B2+B3ó.  The ò=ó tells Excel that this cell is to be 

calculated dynamically, and the òB1+B2+B3ó represents a 

simple addition of the numbers in those three cells. 

 

SHORTCUT: 
Hit ñTabò after 
typing to move to 
the next cell in the 
row.  Hit ñEnterò to 
move to the next 
row (down). 



 
A simple formulaé 

 

Press Enter. 

 

The formula is evaluated by Excel, and you can see the result.  

The number ò350ó represents profit for a small company after 

it pays expenses and rent. 

 

 
Your first model 

 

Notice that if you click on cell B4 again, you can see the 

formula in the formula bar near the top of the window.  The 

cell is dynamic ð if you change the cells it depends on, it will 

recalculate and display a different result. 

 

In this way, we can say that cell B4 is dependent upon cells B1, 

B2, and B3.  Likewise, the numbers representing òincomeó, 

òexpensesó, and òrentó can be called independent variables, 

or inputs. 

  

You have just created your first business model in Excel.  The 

fundamental business purpose of a spreadsheet is to build 

models ð digital approximations of real-world systems.  Notice 

that by changing the inputs income, expenses, and rent, you 

can observe the effect of that change on profit.   

  

Summary 

A spreadsheet, such as Microsoft Excel, organizes information 

in two dimensions and allows the construction of models that 

show the relationships between numbers.  Its format is a grid 

of rows and columns, which intersect to form cells.  These can 

contain text, numbers, or dynamic calculations such as math-

like formulas.  All formulas, even very simple ones, use 



independent variables (also called inputs) to produce a 

dynamic result.  The results depend upon the inputs, so a 

businessperson can change the inputs to see how the results 

will change. 

  

Exercises 

1. If you have used Microsoft software before, you 

probably recognize some of the buttons in the 

Formatting toolbar. 
 

 

In business, itõs important that your spreadsheet be 

easy to read.  Use the tools you recognize to modify the 

example project, as below: 
 

 
 
 

2. Create the following models in Excel, using numbers of 

your choice: 

a. Hours ³ Pay Rate = Pay 

b. Pay ð Tax ð Rent = Cash 

c. Cash · Number of Children = Allowance 

d. Allowance + Piggy Bank = Childõs Cash 

 

3. Which are the independent variables in each of the 

calculations above?  Note that the result of one 

calculation can be the input of another. 

  

4. Combine the four models in #2 to make one large 

model, if you havenõt already done so.  What happens 

to Allowance when Hours is increased?  What happens 

to Childõs Cash when Number of Children is increased?  

What happens to Piggy Bank when Pay Rate is 

increased?  Why? 

 

5. Connect to the Internet and do a quick search for 

òspreadsheet software.ó  What other major brand 

names offer spreadsheet software in competition with 

TIP: 
In your formulas, 

use *  to multiply (³) 

and use /  to divide 

(·) 



Microsoft Excel?  What differences and benefits do they 

claim to offer? 

 

 



 

 

 

Modeling Lesson 1 

Introducing Models 

Models, as we mentioned in Chapter 1, are approximations or 

simplified copies of real-world systems.  In Excel, we are 

typically creating spreadsheet simulations of business or 

financial systems.  These models can be used by analysts and 

managers to solve problems, make decisions, or predict what 

will happen in the future. 

 

A system is a group of factors ð people, companies, things, 

processes ð that work together to produce some kind of result.  

A system can be analyzed in terms of its inputs, its outputs 

(the dependent outcomes of the model), and the relationships 

between them.  For example, the system you simulated in 

Chapter 1 could be sketched out like this: 

 
Inputs 

(independent variables) 

Relationships 
(rules) 

Outputs 
(dependent results) 

  

 
income 

- expenses 

- rent 

= profit 

 

A sketch of a simple profit model 

 

You are certainly very excited to learn more about using Excel.  

However, the first step to creating an effective model is often 

to pick up a pencil and paper.  Before setting up any 

spreadsheets, itõs essential to make sure you understand the 

business situation fully and accurately.  We will use the 

following as a guide: 

 

Steps to creating a model in Excel: 

income 

expenses 

rent 

profit 



1. Make sure you fully understand the business 

question/problem.  What output(s) must you find? 

2. Determine what inputs you need.  What information do 

you have access to?  What factors can you control? 

3. Identify the rules or relationships between inputs and 

outputs that make the real-world system work. 

4. Plan and implement the spreadsheet model in Excel. 

 

Starting your Modeling Career 

In each subsequent Modeling Lesson, we will build a pair of 

meaningful models based on business case studies.  Because 

we havenõt yet learned enough about using Excel, this first 

lesson will be conceptual only.  So put down your mouse, pick 

up a pen and paper, and follow along. 

 

Jinõs Golden Taxi Company 

Mr. Jin, an auto enthusiast, has decided to start his own taxi 

cab company in Beijing.  He asked a few friends and found out 

how the taxi business usually works.  Taxi drivers rent the cars 

from the taxi company for a rate of 50¥ to 200¥ per day.  The 

drivers take care of fuel and maintenance, so Mr. Jin doesnõt 

have to worry about those costs, and the drivers keep any 

extra profits they make. 

 

Mr. Jin has the choice of buying expensive, new cars or 

cheaper, older cars.  The newer cars will probably last longer, 

and he can charge a higher rent to his drivers, so they may 

generate more profit.  On the other hand, the older cars may 

òpay for themselvesó sooner, so he wonõt have to go deeply 

into debt. Heõd like to compare the possibilities so he can 

decide what the best way to start his new business is. 

 

Understand the question? 

Mr. Jin wants a spreadsheet to compare different types of cars 

for his business.  From the second paragraph we can see that 

two outputs are particularly important to him: 

 

¶ profit 

¶ payback period 

 

òProfit,ó of course, means the amount of income generated 

minus the costs incurred.  We could measure profit per year, 

or the total profit over the lifetime of a car.  òPayback periodó 

means the amount of time required for an asset to earn its 

purchase price.  If a taxi costs 80,000¥, and it earns 



40,000¥ per year, its payback period is two years.  Weõve 

identified the two outputs our model should produce. 

 

What can we control? 

The inputs to the model are all the factors that we (or Mr. Jin) 

can control.  These are the independent variables that he will 

adjust to observe changes in the output.  Letõs take a brief 

inventory of the information we need to produce the two 

outcomes of profit and payback period. 

 

Mr. Jin is going to compare cars that have different prices, so 

weõll need the carõs purchase price as an input.  He believes 

that some cars will last longer than others, so another input 

might be the useful life of a car.  A third input we need to 

calculate total profit is the price that he can sell the car for at 

the end of its useful life.  Mr. Jin is also going to adjust the 

rental fee he charges his drivers.  The four main inputs to the 

model are: 

 

¶ purchase price of car 

¶ useful life of car (in years) 

¶ re-sale value of car 

¶ daily fee charged to driver 

 

How do they fit together? 

Now that we know the inputs and outputs, letõs try sketching 

out how the numbers work together.  In this model, profit per 

year is quite simple ð just the daily rent multiplied by 365.  

The payback period is the purchase price of the car divided by 

the profit.  Divide by the daily profit to get the payback period 

in days, or by the yearly profit to get the payback period in 

years.  To find the total profit, we multiply the yearly profit by a 

carõs useful life, subtract the purchase price, and add the re-

sale value.  Make sense?  Your notebook should now look 

something like mine: 

 



 

 

In Modeling Lesson 2, weõll discuss how to implement this 

model in Excel.  For now, turn to a fresh page and sketch out 

the second model. 

 

The Driverõs Side 

Johnny Driver is a young man who just arrived in the city and 

thinks that driving a taxi might be a good way to make some 

money.  He heard that he can rent a car from one of the big 

taxi companies from between 50¥ and 200¥ per day, that 

heõll have to pay for his own fuel, and that he can keep any 

profit he makes after paying those fees.  He believes that a 

taxi picks up about five fares per hour and that the average 

fare is about 15¥.  The cost of fuel is currently 7.9¥/L, and the 

average taxi uses 6L of fuel per hour.   

 

Johnny wants to know how many hours he must drive each 

day, minimum, in order to pay for the rental fee, and he wants 

to know how much profit he can earn if he drives for a few 

extra hours.  He believes that, if he pays more to rent a better 

cab, he can pick up more fares per hour, and use less fuel per 

hour.  Furthermore, heõs worried about the price of fuel 

increasing, and wants to know how seriously that would hurt 

his profits. 

 

Exercise 

1. Sketch out the inputs, outputs, and rules for the model. 

Keep this sketch, youõll use it in Modeling Lesson 2. 

 

 



 

 

 

 

 

CHAPTER 2:  Formulas and 

Functions  

Excel formulas 

Excel is not a calculator, but its ability to perform 

mathematical calculations is extensive.  From simple 

arithmetic, to trigonometry, to sophisticated statistical analysis, 

itõs all in Excel somewhere. 

 

The most important thing to remember is that all formulas in 

Excel look like the right side of an algebraic equation.  They all 

begin with ò=ó.  There are four arithmetic operators in Excel: 

add (+), subtract (- ), multiply (* ), and divide (/ ).  In your 

formulas you can use numbers, cell references, or both.  For 

example: 

 

=1+1 

=A1- B1 

=B2*100  

=1/A3  

 

Two other operators you might sometimes use are ò^ó, which 

raises a number to an exponential power, and ò%ó, which 

divides by 100 and displays the result as a percentage. 

 

 =3^2   (represents ò32ó or 9) 

 =75%   (represents 0.75) 

 

Just as in high school math class, multiplication and division 

takes precedence over addition and subtraction.  That is, ò*ó 

and ò/ó are evaluated before ò+ó and ò-ó.  You can override 

this by using parentheses in your formulas. 

 

 =1+1*100   (represents 101) 

COMMON 
MISTAKE: 
Try not to forget the 
ñ=ò.  Itôs an easy 

mistake to make. 

TIP: 
For more 
information on 
mathematical 
calculations in 
Excel, try using 
Excelôs online Help.  
Click the ñHelpò 
button in the 
Standard toolbar, 
and follow the 
prompts. 

 



 =(1+1)*100  (represents 200) 

 

Example: Employee Time Table 

If you have a computer handy, open a new Excel file now.  We 

will practice using formulas to create a model for scheduling 

the work of three employees.  Set up the model as in the 

illustration below, with a title for the spreadsheet and names 

for three employees. 

 

 
Set up the model 

 

Before developing this model further, letõs practice using the 

basic formatting tools to make this spreadsheet clearer and 

easier to read.  Select all the cells by clicking in the space 

above the row numbers and to the left of the column letters.  

Then click the òCenteró button on the Formatting toolbar. 

 

 

 

 
Some important formatting controls 

 

 

Once youõve centered all the cells, click cell C1 and press the 

òBoldó button.  The title should now be clear and nicely 

centered over the three employeesõ names. 

 

TIP: 
If the toolbars you 
need (such as the 
Formatting toolbar) 
are not visible, you 
can activate them 
from the View 
menu. 

bold center 

currency style 

text color 

Click here to select all the cells 



The numbers indicate that each employee works four hours on 

Monday.  Enter a formula into cell E4 to show the total number 

of person-hours worked on that day: =B4+C4+D4 

 

 
Proper formatting and an arithmetic formula 

 

Saving time with Fill 

Excel has many features to save your time and energy, none 

more elegant than Fill, also called òAutofilló.  Look for the fill 

handle, the little, square black òdotó usually located at the 

bottom right corner of any cell youõve selected.  When you 

move the mouse over the fill handle, your cursor changes to a 

black cross. 

 

 
The fill handle 

 

Select cells B4 to D4 now by clicking in cell B4 and dragging 

the mouse to cell D4.  Then let go of the mouse button.  Move 

the mouse over the fill handle, then click and drag down four 

rows, to cell D8.  If Fill worked correctly, you now have a 3x5 

matrix of the number 4. 

 

 
Automatically copying numbers 

 

If that impressed you, prepare now to be totally amazed.  Excel 

can Fill a series of values based on its best guess of your 

intentions.  Click on the cell containing òMondayó and drag the 

fill handle to fill the four cells below it.  Excel will automatically 

insert òTuesday,ó òWednesday,ó and so on into these cells. 

 

SHORTCUT: 
Instead of typing 
the whole formula, 
just type ñ=ò, click 

on cell B4, type ñ+ò, 

click on cell C4, 
type ñ+ò, and click 

on cell D4, then hit 
Enter. 

fill handle 



Now use Fill to copy the formula in cell E4 down.  Excel 

modifies the cell to show the sum for each individual row.  This 

will be explained further in  

 

 

CHAPTER 3:  Keeping Track of Your Cells. 

 

 
Table completed with Fill 

 

A couple of basic functions (SUM, AVERAGE) 

The second type of dynamic calculation you can use in Excel is 

a function.  The word òfunctionó is used in both mathematics 

and computer science to represent a calculation slightly more 

complex than simple arithmetic.  There are hundreds of 

functions in Excel ranging from quite simple to extremely 

specialized.  Some of the ones you might frequently use are: 

 

 SUM   (adds numbers) 

 AVERAGE  (finds an average) 

 SQRT   (calculates a square root) 

 ROUND  (rounds off a fraction) 

 

To use a function in Excel, as with a formula, you must first 

enter ò=ó.  The function name is followed by parentheses.  

Each function requires a specific number of arguments, 

separated by commas, inside the parentheses.  For example, 

we will use the very simple function SUM.  In cell B9, enter 

ò=SUM(B4:B8) ó to calculate the sum of the first employeeõs 

working hours. 

 

SHORTCUT: 
Instead of typing 
the whole formula, 
just type ñ=SUM(ò, 

use the mouse to 
select the cells you 
want to total, then 
type ñ)ò and hit 
Enter. 



 
Entering a function 

 

Using the SUM function is easier than using a formula like 

ò=B4+B5+B6+B7+B8ó, and youõre much less likely to make a 

mistake entering it. 

 

As above, use Fill to copy the formula horizontally, so you have 

a SUM function for each employee.  If youõve done it correctly, 

column E now shows a total of 12 hours for each day, and row 

9 now shows a total of 20 hours for each employee. 

 

If we were really preparing a work schedule for employees, 

these totals would be important to us.  We would want to 

make sure that the business was staffed for a certain number 

of hours every day (for example, 12) and that employees 

received enough hours to make them happy (at least 10 hours 

per week, perhaps).  However, they arenõt the really important 

outputs for this spreadsheet, so letõs reduce their importance.  

Select these cells and change the text color to gray.  (See the 

figure on page 17.) 

 

A more important output is the average number of hours per 

day that each employee works.  Type òavg. hrs.ó in cell A10, 

and the formula ò=AVERAGE(B4:B8)ó in cell B10.  Then 

copy the formula across.  Does your spreadsheet look like the 

figure below? 

 



 
Applying SUM and AVERAGE functions 

 

You can now manipulate the hours in cells B4 to D8 to see 

how your changes impact the totals and averages.  Change the 

schedule as you like, making sure that a total of exactly 12 

hours are assigned on each day. 

 

Putting formulas and functions together 

Cells can represent dynamic calculations even more complex 

than formulas and functions ð they can use formulas within 

functions, functions within formulas, or functions within 

functions, and more.  I generally recommend keeping your 

spreadsheet as simple as possible, to make it easier to 

understand and modify, but in some cases a combination of 

function and formula is easy and efficient. 

 

Continuing with our Employee Time Table model, enter the 

employeesõ pay rate in row 11, as follows.  You can set the 

numbers to anything you like.  To make the numbers appear 

as currency, select cells B11 to D11 and click the Currency 

Style button on the Formatting toolbar. 

 

Then in row 12, with the label òtotal payó, enter the formula 

ò=SUM(B4:B8)*B11 ó, which combines a SUM function with 

multiplication. 

 



 
Putting money into the model 

 

The most important thing in this model, of course, is money.  

Now that we have some currency figures in the model, it 

becomes far more interesting.  Try to create a ògrand totaló 

cell, with a SUM function or an arithmetic formula, whichever 

you prefer.  This complete model gives you the power to 

change employeesõ work schedules and pay rates, to see how 

you can meet your staffing needs while saving money. 

 

 
A complete model, with emphasis on the òbottom lineó 

 

Summary 

Cell values can be dynamically calculated in Excel with 

algebra-like formulas, with a wide variety of functions, or with 

some combination of both.  When entering any formula or 

function, you must begin with ò=ó.  Two of the most commonly-

used functions are SUM and AVERAGE.  Formulas and 

TIP: 
You donôt have to 
type the function 
name in capital 
letters.  Excel is 
equally happy with 

ñSUMò, ñsumò, and 

ñSumò. 



functions can be used together to make interesting business 

models like the example in this chapter. 

Exercises 

1. Create a spreadsheet of your family membersõ ages, 

and calculate the total and average age, as in this 

example: 

 

 Age 

Grandmother 72 

Father 51 

Mother 49 

Me 22 

The dog 4 

  

Total:  

Average:  

 

2. Use Excel to design a òreceiptó for a grocery store 
purchase, calculating the total price of all items, the tax 

due (based on a sales tax rate of 5%), and the grand 

total. 

 

3. Pretend youõre a teacher.  Create a ògrade sheetó that 

lists the scores for several students on five exams.  Use 

AVERAGE to calculate each studentõs average grade 

for the semester, and to calculate the classõs average 

score on each exam. 

 

4. Build a model to find the length of the long side of a 

right triangle, using Pythagorean Theorem.  (a2 + b2 = 

c2)  Your inputs are òaó and òbó, the short sides of the 

triangle, and one output cell should clearly indicate òcó.  

Youõll need to use the SQRT function. 

 

 

 



 

 

 

Modeling Lesson 2 

Jinõs Golden Taxi Company 

Remember the model we sketched out on page 15? 

 

 

Sketch of JGTC model 

 

Now that youõre equipped with the basic tools for creating 

spreadsheets, letõs implement the model in Excel. 

 

One of the key things to think about is that Mr. Jin doesnõt 

want to deal with a lot of formulas, functions, and 

intermediate numbers.  He just wants to manipulate the input 

cells, and see how the output cells change.  To make a user-

friendly model for him, weõll put the inputs and outputs at the 

top, left corner of the model, and put our calculations down 

below, where they wonõt bother him.   

 

There are many ways to organize your spreadsheet to make it 

user-friendly, easy for non-technical people to understand and 

use correctly.  One example is given below.  If you are reading 



a color copy of this book, youõll see that it uses the color green 

to identify input cells that can be adjusted, and red or yellow to 

identify the modelõs outputs. 

 
User-friendly model display 

 

Once you have prepared a user-friendly display of the modelõs 

inputs and outputs, enter some example data for each of the 

inputs and scroll down to an empty part of the spreadsheet to 

begin creating the interesting parts of the model. 

 

The simplest formula possible in Excel is a simple ò=ó, which 

brings another cellõs data to the current cell.  Use it to make 

òcopiesó of the inputs in your working space somewhere down 

below. 

 

 
For your eyes onlyé 

 

Down here in the 25th row, we can perform all the calculations 

just as we planned them in the previous modeling lesson. 

 

TIP: 
Use the Borders 
control in the 
Formatting toolbar 
to make a ñboxò 
around a cell. 

 

 
 
Use the mini-menu 
(by clicking the 
small triangle) to 
select different 
types of borders for 
the top, bottom, and 
sides of the cell. 



 
A few simple calculations 

 

Finally, use the simple ò=ó formula again to display the 

outputs in the places you prepared for them at the top of the 

spreadsheet.  This model is almost finished, but there are two 

small matters we must attend to. 

 

First of all, the numbers that represent money must be 

formatted as currency.  In this case, weõll use the Chinese 

yuan.  Select the input variable that represents òcar purchase 

priceó.  Then go to the Format menu and select òCellséó 

 

 
Format > Cellsé 

 

In the Format Cells window, click to the òNumberó tab.  (Tabs 

are the buttons at the top of the window that organize features 

into òpages.ó)  This cell will be formatted as òCurrency,ó so 

select that from the Category list.  Choose the Symbol from the 

list that represents the Chinese yuan, and choose the number 

of decimal places you want to display.  Then click òOK.ó 

 



 
The Format Cells window 

 

Repeat these steps with all the other input and output cells, 

except those that do not represent currency ð the òuseful lifeó 

and òpayback periodó variables. 

 

Thereõs only one thing left to adjust, and that is the payback 

period cell.  Mr. Jin doesnõt want or need to know that the car 

will pay for itself in, for example, 2.739726027  years.  He 

would be happy with a number like ò3.ó  This is an easy 

problem to solve, however, with the Excel function ROUNDUP.   

 

ROUNDUP requires two arguments: the number to be rounded 

up, and another argument called ònum_digitsó representing 

the number of decimal places to round the number to.  If your 

payback period formula is in cell F26, use the function 

ò=ROUNDUP(F26, 0)ó.  This tells Excel to round F26 up to 

the nearest integer (zero decimal places). 

 

TIP: 
ROUNDUP is closely 

related to the Excel 

formulas ROUND 

and ROUNDDOWN.  

They work very 
much the same but, 
as you can probably 
guess, ROUNDUP 

always rounds up 
and ROUNDDOWN 

always rounds 
down, while ROUND 

always rounds to 
the nearest 
possibility. 



 
A completed model 

 

Now the model is complete.  Itõs not important if your model 

looks the same as the example here -- use your creativity and 

communication skills to design a model thatõs easy for you 

and others to understand. 

 

Exercises 

1. Putting the model to the test 

Imagine you are Mr. Jin, and youõre about to buy the 

first car for your company.  You have shopped around 

and found a few different deals: 

¶ A brand-new model from Korea for 150000¥, 

which will probably last 8 years and still be 

worth 30,000¥.   Drivers would pay 125¥ per 

day to use it. 

¶ A two-year-old model from Germany for 

110,000¥.  You could use it for 6 years and sell 

it for about 20,000¥.  Drivers would pay 

110¥ per day. 

¶ A 50,000¥ deal on a five-year-old compact car 

from Russia.  It will probably last only 3 years, 

and you might be able to sell the tires for 



1000¥ after that.  Drivers would pay 65¥ per 

day. 
 

Which car will make the greatest overall profit for your 

company?  Which one will pay for itself fastest, freeing 

you from debt?  Which one would you choose to buy? 

 

2. The true yearly profit 

The true òprofit per yearó should take into 

consideration the purchase price of the car and its 

resale value.  To make the model more accurate, 

adjust the formula for yearly profit so that it equals the 

total profit, divided by the useful life of the car. 

 

3. Delinquent drivers 

Mr. Jin suspects that drivers sometimes fail to pay their 

fees.  He guesses that he will only collect the full fees 

about 75% of the time, perhaps more or less.  Add the 

new independent variable and update the model. 

 

Johnny Driver 

Implement Johnnyõs model as an Excel spreadsheet.  If 

Johnnyõs assumptions are correct, how hard will he have to 

work to pay the cab rental fee?  How much money can he earn 

by working an 8-hour day?  What about a 12-hour day?  Which 

of Mr. Jinõs taxis would Johnny prefer to drive? 



 

 

 

CHAPTER 3:  Keeping Track of 

Your Cells 

Excel Organization 

You may have noticed that files in Excel are called workbooks.  

Unlike a file in a word processor like Microsoft Word, an Excel 

workbook offers the user a nearly limitless two-dimensional 

space in which to construct a model.  With 256 columns and 

65,536 rows, an Excel spreadsheet is a big place, and some 

system of organization is necessary. 

 

To help you keep track of things, an Excel workbook can 

contain multiple worksheets, also called sheets, each one an 

equally huge 2D space.  You can move from worksheet to 

worksheet by clicking the tabs at the bottom left of the Excel 

window, just as if they were pages in a book.  You can add, 

delete, or rename individual worksheets by right-clicking these 

tabs. 

 

 
Worksheet tabs 

  

Use worksheets to keep your Excel projects organized and 

readable.  A very common structure is to put some sort of raw 

data on one sheet, some calculations on a second sheet, and 

the òpresentation,ó with professional charts and labels, on a 

third sheet. 

 

Everythingõs relative 

Since each worksheet can contain 16,777,216 cells, and an 

Excel workbook can contain several worksheets, we should 



learn a little bit about how cells are identified by Excel.  As 

discussed in Chapter 1, the òaddressó of a cell is its column 

letter and its row number.  This is formally called a cell 

reference. 

 

The most common type is a relative cell reference, like this: 

 

A1 
A relative cell reference  

 

A group of cells selected together is called a range.  A range is 

identified by its top left cell and its bottom right cell, in a 

format called a range reference.  A range can be a set of cells 

stacked vertically like òA1:A6,ó a set of cells lined up 

horizontally like òB2:D2,ó or a rectangular block of cells like 

òC4:D5.ó 

 

 

 
Range references 

 

If a range reference contains relative cell references, then the 

range reference, too, is relative.  A relative cell or range 

reference in a formula or function represents the position of 

the cell or range, relative to the location of the formula.  Thatõs 

a little bit difficult to think about, so weõll use a picture to 

explain. 
 

 

 

 
Using relative cell references 

 

 

B2 means ñthe cell two 
columns to the left of hereò 

 

C2 means 
ñthe cell just 
to the left of 
this oneò 

 

A2 means ñthe cell 
one column left and 
four rows aboveò 

 

Range A1:A6 
 
 

Range B2:D2 
 

Range C4:D5 
 

B2:B3 means ñthe two 
cells above this oneò 

 



 
 

As you can see from the illustration, the cell references that 

look like definite òaddressesó to humans are not understood 

the same way by Excel.  Instead, Excel reads them as 

òdirectionsó to find a cell.  This is actually very useful. 

 

Notice the function in cell D2 that calculates a total for 

òApplesó.  If you want a total for òBananasó as well, you could 

type ò=SUM(B3:C3) ó into cell D3, but thatõs not necessary.  

Because D2õs formula uses a relative range reference, you 

can simply copy it and paste it into cell D3.  In both rows, the 

function works correctly: it adds the two cells to the left of it.  

Likewise, you can copy the function in cell B4 to cell C4.  In 

both columns, this function calculates the total of the two cells 

above it. 

 

The little formula in cell B6 of the example is interesting.  You 

could copy it and paste it into the entire range B5:E8, to 

exactly repeat everything in the model above it.  Then paste it 

into cells C9:F12, to repeat it again, and so on. 

 

Absolute certainty 

There are certain times, of course, when you want to refer to a 

specific cell, so that you donõt lose track of it when you copy a 

formula.  In these cases, you can use an absolute cell 

reference.  Adding dollar signs (ò$ó) to the cell reference make 

it clear and specific. 

 

$A$1 
An absolute cell reference  

 

Consider the example of a company that wants to know which 

products make up the largest part of its sales revenue.   

 

 
Revenue for three products 

 

TIP: 
Copying and 
Pasting works the 
same way in Excel 
as in other 
Microsoft programs.  
Select ñCopyò from 
the Edit menu or 
press Ctrl-C.  Select 
ñPasteò from the 
Edit menu or press 
Ctrl-V. 



In order to fill the ò% of totaló column, the company must first 

calculate the total revenue for all three products.  You can do 

this in cell B5 with a formula or a SUM function, as you prefer. 

 

Think a moment about column C.  To find a percentage of a 

total, you can usually use this rule: òsmall number ÷ number 

numberó.  Divide each sales number by the total in cell B5.  

You will use the same denominator in all three calculations.  

Therefore, the cell reference for B5 must be absolute. 

 

The formula you need for cell C2 is ò=B2/$B$5 ó.  Enter this 

formula and copy it to fill cells C3 and C4.  Finally, select the 

range C2:C4 and click the Percent Style button in the 

Formatting toolbar to make it look the way we want. 

 

 

 
The Formatting toolbar 

 

 
The complete example 

 

Naming cells and ranges 

In a very small model like the one above, an absolute cell 

reference works quite well, but can you imagine a large, 

complicated model using lots of relative and absolute 

references in a variety of different formulas and functions?  

Setting it up would be very confusing and it would be difficult 

to know whether or not you had made mistakes. 

 

Fortunately, there is a better way to reference cells and ranges 

in an absolute way.  You can give them names.  Notice the 

Name Box. 

 

SHORTCUT: 
The SUM function is 

used so often in 
Excel that thereôs a 
special button for it.  
Look for the 
AutoSum button in 
the Standard 
toolbar. 

 

Percent Style 
 



 
The Name Box in an Excel window 

 

The Name Box displays the address of the cell or range 

currently selected.  You can assign a name by first selecting 

the cell or range, then typing something into the Name Box 

and pressing Enter.  You can do more things with cell and 

range names, such as changing or deleting them, by selecting 

Name > Define from the Insert menu. 

 

 
Setting cell/range names with the Insert menu 

 

Assign a name to cell B5 now.  A simple name like òtotaló 

would be fine.  Now re-enter the formula in cell C2, using the 

name instead of an absolute cell reference.  For example, 

ò=B2/total ó.  Isnõt that clearer? 

 

Using mixed row and column references 

Sometimes you might want to reference a cell such that the 

row number is relative but the column letter is absolute, or 

Name 
 Box 

 

COMMON 
MISTAKE: 
A range name 
cannot contain any 
spaces.  Instead of 
ñgrand totalò, you 
can use a name like 
ñgrand_totalò or 
ñGrandTotalò. 



vice-versa.  This is easy to do in Excel, but be warned, your 

formulas will be increasingly difficult to understand if you donõt 

use range names instead.  To quickly change the type of a cell 

reference, use the F4 key. 

 

To see how this works, select an empty cell and type ò=A1ó, 

but do not press Enter.   

 

1. Press F4.   The cell now contains the absolute 

reference ò=$A$1ó. 

2. Press F4 again.  The cell now contains ò=A$1ó.  The 

row number ò1ó is absolute and the 

òAó is relative. 

3. Press F4 again.  The cell contains ò=$A1ó.  The 

column letter òAó is absolute and the 

ò1ó is relative. 

4. Press F4 again.  The cell reverts back to the relative 

reference ò=A1ó. 

 

One very simple example that requires mixed use of relative 

and absolute references is a multiplication table, like the one 

most of us memorized in grade school.  Create a table like the 

following in an empty Excel worksheet: 

 

 
Empty multiplication table 

 

Each cell must multiply the number in row 1 above it by the 

number in column A to the left of it.  If you use absolute 

references or relative references, the table will be incorrect.  

Instead, use a reference to the numbers above with only the 

ò1ó absolute, and a reference to the numbers on the left with 

only the òAó absolute.  Enter the following into cell B2: 

 

 =B$1*$A2  

 

TIP: 
Itôs easy to change 
the width of 
columns.  Move 
your mouse over 
the line between 
two columns until 
you see the two-
headed arrow 
cursor.  Then click 
and drag to re-size 
the column.  
Row height can be 
adjusted in the 
same way. 



Now copy this cell, select the entire table, and paste the 

formula.  If your memory of grade school is good, you shouldnõt 

need a calculator to check whether the result is correct. 

 

How about using range names?  They work here, too.  Select 

òUndoó from the Edit menu or press Ctrl-Z to undo what you 

just completed and revert to an empty multiplication table.  

This time, assign the name ònumberAó to the range A2:A13, 

and the name ònumberBó to the range B1:M1.  Enter the 

formula ò=numberA*numberB ó in any table cell and copy it 

to the rest of the table.  Is there any difference in outcome? 

 

Iõll tell you the difference.  When you used the range names, 

you produced a model thatõs far easier to understand and 

check.  Good work! 

 

In case you get confused 

All these cell references can get complicated.  Just in case you 

get confused, Excel provides the Formula Auditing toolbar.  To 

activate it, select Toolbars from the View menu, and make 

sure that òFormula Auditingó is checked.  You can use this 

menu to activate any of several useful toolbars. 

 

 
Choosing toolbars to display 

 

The features in the Formula Auditing toolbar let you find the 

cells that a formula/function depends on (Trace Precedents) 

or the cells that depend on it (Trace Dependents). 



 

 

 
The Formula Auditing toolbar 

 

 

If you find yourself lost in a very complicated model, remember 

the tools in this toolbar.  They are powerful aids to help you  

understand and troubleshoot any spreadsheet. 

 

 
Using òTrace Precedentsó on cell C3 

 

Summary 

Excel files are called workbooks and they can contain multiple 

two-dimensional òpagesó called worksheets or sheets.  Each 

worksheet can contain millions of cells, and there are a variety 

of ways to identify cells.  Groups of cells are called ranges.  

The most common type of òcell addressó is a relative cell 

reference, which will change as a formula or function is copied 

or moved.  To use a specific cell in multiple formulas, you can 

use an absolute cell reference, or better, assign a name to the 

cell or range.  Names make your spreadsheet easier to 

understand and less likely to contain mistakes.  In various 

situations, you may choose to make only the row or column 

part of a cell reference absolute, and the other part relative.  If 

you get confused while writing formulas, use the Formula 

Auditing toolbar to check relationships between cells. 

 

Exercises 

1. Create a new workbook, with three worksheets.  

Rename the worksheets òDataó, òModeló, and 

òPresentationó. 

 

2. In an empty worksheet, enter ò=A1ó in cell B1.   

a. If you copy this cell and paste in cell C5, what 

formula will cell C5 contain?   

Trace Precedents 
 

Trace Dependents 
 
 



b. What would be the result if your original formula 

was ò=$A$1ó?   

c. What would be the result if your original formula 

was ò=$A3ó? 

 

3. Create a list of prices like this: 

 
Using an absolute reference to the tax rate in cell B1, 

calculate the sales tax on each product, and the total 

price (base price + tax). 

 

4. Create a table like the multiplication table on page 35.  

Instead of multiplying, fill the cells with a formula that 

uses Pythagorean Theorem to find the long side of a 

right triangle.  (The equation is a2 + b2 = c2.  Your 

formula must find òcó.) 



 

 

 

Modeling Lesson 3 

Manager Bing of Haerbin Refrigerators 

Mr. Bing is the proud manager of eight salespeople at Haerbin 

Refrigerators, a specialized refrigerator store in Haerbin, China.  

His salespeople are mostly excellent; in fact Mr. Bing trained 

them himself.  But he is not an accountant and sometimes he 

isnõt sure how much money theyõre actually making him.  Our 

task is to find out. 

 

Refrigerators cost ¥500 from the factory, and the company 

currently sells them for ¥699 each.  The sales team is paid a 

combination of salary (the same amount each month) and 

commission (a percentage of their sales). 

 

After paying his salespeople, Mr. Bing must also pay taxes.  He 

actually has to pay the government twice for every refrigerator 

he sells: a òsales taxó when he makes a sale (currently 5%), 

and a òprofit taxó at the end of the year (currently 12%), if his 

company turns a profit.  After taxes, he can keep the rest of 

the money he earnsé until his wife and children get their 

hands on it, that is! 

 

What are the inputs? 

There are six factors in this equation: 

 

¶ factory cost of refrigerators (¥) 

¶ selling price of refrigerators (¥) 

¶ salespersonõs salary (Ô) 

¶ sales commission (%) 

¶ sales tax rate (%) 

¶ profit tax rate (%) 

 

In addition, Mr. Bing has provided the accounts of each team 

memberõs sales for the most recent month.  Give the 



salespeople any names you like, but set the amounts to: 88, 

69, 105, 72, 40, 99, 82, and 57. 

 

Because there are eight salespeople, and there will be several 

calculations, we will use a large table as our output display.  As 

in the previous lessons, weõll use the color green to indicate 

input variables, and the color red to highlight the most 

important output cells. 

 

 
Setup of input and output presentation 

 

This spreadsheet design allows us to build a table on the right, 

with several rows of calculations for each salesperson.  To 

begin this process, assign a range name to each of the input 

variables (six names in all).  Remember, names cannot include 

spaces; òcostó or òrefrigerator_costó will work, but òrefrigerator 

costó cannot be a range name. 

 

 
Setting a range name for cell B7 

 

Now, build the table at right.  Think about the order in which 

you make calculations.  The òtop lineó is revenue, the money 
TIP: 
These terms come 
from a fundamental 
type of financial 
accounting 
document called an 



that the store takes in.  It is equal to the unit sales times the 

selling price of a refrigerator.  After that, four costs are 

subtracted: the cost of refrigerators, the sales tax, the 

salespersonõs commissions, and the salary (which is static, 

meaning it doesnõt change).  The remaining amount is 

operating profit.  Then, subtract profit tax and find the òbottom 

lineó, or net profit. 

 

Revenue is money received, and all the other lines (except 

profit) are costs.  You may find it easy to enter the revenue as 

a positive (+) number, the costs as negative (-), and the profit 

lines as SUM functions.  Or express all the lines as positive 

numbers, and use subtraction to find profit.  In the example, 

we use the former approach. 

 

 
Calculating tax cost as a negative number 

 

Using Fill, complete the table.  This is not very easy to read, 

because there are a lot of numbers and they are all the same 

color.  You might change the color or style of the important 

rows (revenue, operating profit, net profit), but thatõs optional.  

What we really need is a big red output box showing the total 

amount of money that Mr. Bing gets to keep after taxes.  How 

much is he making?   

 

 
The answeré did you get it? 

 

 

 

 



Exercises 

1. Adjusting the compensation mix 

One of the first things that Mr. Bing noticed on the 

report is that one of his employees, Rose, sold 40 

refrigerators last month, but is not earning a profit for 

the store.  How can you adjust the salary and 

commission rates so that the total pay to employees is 

about the same, but every employee is bringing in a 

profit?  Which employees would be happy with your 

proposal and which ones unhappy? 

 

For this task youõll probably want to add a line to the 

table for òtotal pay to employeeó, adding their salary 

and commission, and add an output cell for the total 

pay to all employees. 
 

2. Everything in proportion 

Mr. Bing is happy to know his total profit, but heõd also 

like to know how much profit he makes for each 

refrigerator.  Create a new output measure that divides 

total profit by the total number of refrigerators sold.  If 

Mr. Bing closes the store at 6:00pm, and a customer 

knocks on the door while he is eating dinner, is one 

sale worth the effort of getting up from the table? 

 

3. The effects of variable and fixed costs 

Marginal profit per unit (thatõs what you just calculated) 

is a function of variable and fixed costs.  In this case, 

salary is a fixed cost (itõs the same no matter how many 

refrigerators are sold) and all the other costs are 

variable.  What happens to the profit per refrigerator if 

the number of refrigerators sold by each salesperson is 

doubled?  If that happened, would Mr. Bing prefer his 

original pay mix, or the new mix you proposed in 

Exercise 1? 

 

Heilongjiang Wholesalers, Ltd. 

Heilongjiang Wholesalers is a supplier of appliances (like 

refrigerators, freezers, and water coolers) to department 

stores and specialty stores all over Heilongjiang Province.  

Theyõre introducing a new product this year: a super-deluxe 

refrigerator with a television and internet access built-in.  You 

are in charge of deciding which stores to sell it in. 

 



The marketing department says that you will have to train the 

employees of the stores you sell the new product to.  Itõs 

cheaper to train a large sales force than a small sales force.  

In fact, the cost of training is estimated to be ¥2000 times the 

square root of the size of the sales force.  

esalespeoplofnumberstcotraining ³º2000  

 

It is believed that the average salesperson will bring in ¥90 of 

profit each month, selling this new product.  Design a model 

that shows how many months you will need to turn a profit by 

selling the product in stores of different size.  You may use a 

matrix like the one below, with mixed absolute and relative 

references, to find answers quickly. 

 

Customer: 
Haerbin 
Refrig. JLF CSF WMT XYZ 

Sales team size: 8 45 18 30 4 

Months      

1 

(profit) 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

Table for comparing customers over  time 

 

Consider these questions:  How many months will it take to 

make a profit?  Do you make more profit in a year by focusing 

on big stores, or by selling to every store?  If you have a limited 

budget for training, how can you maximize your profit? 



 

 

 

CHAPTER 4:  Charts and 

Graphics 

Using graphics to make your point 

In the previous three chapters, you worked hard to understand 

some difficult concepts.  Having acquired that foundation, you 

can now create all sorts of powerful and interesting models in 

Microsoft Excel.  Congratulations! 

 

In this chapter we will learn to create graphics in Excel ð visual 

elements that help to explain your model or express a 

message.  Because spreadsheets contain a lot of numbers, 

and businesspeople have little time, graphics are essential for 

summarizing and illustrating your work. 

 

For you, the spreadsheet developer, graphics offer a 

secondary benefit.  While it is actually quite easy to produce 

professional-quality graphics with the software, Excel 

òoutsidersó donõt know this.  You can impress bosses and 

colleagues by adding some Excel graphics to your work 

documents and reports. 

 

Introducing Excel charts 

When most people think about Excel graphics, they think 

about charts.  These are graphics generated by the 

spreadsheet that represent numerical data as pictures.  The 

most popular types are pie charts, column and bar charts, and 

line charts.  Each type has a different purpose. 

 



Managers' Time Use

training: 20%

staff meetings: 

10%

sales activities: 

30%

management 

meetings: 12%answ ering 

phone/e-mail: 

28%

 
 A Pie Chart 

 

The purpose of a pie chart is to show a group of numbers as 

portions of a whole.  It is useful in a model where several 

items are added to form a total, and you are interested in 

seeing how the items compare in importance. 

 

Earnings by Product
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 A Bar Chart A Column Chart 

 

Bar charts and column charts are often used to compare 

absolute values of different items.  They only differ in that bar 

charts are horizontal and column charts are vertical.  These 

charts can show two or three dimensions of data, and are very 

common in many different types of models. 

 

Earnings 1999 - 2006
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A Line Chart 

 

The special strength of a line chart is its ability to show how a 

value changes over time.  Instead of comparing different items 

at one moment in time, a line chart looks at a single item at 

various time points.  It can show historical changes, current 

trends, or future predictions.  They are very important for 

financial models, and you will often see them in finance 

newspapers and magazines. 



 

Calling on the Wizard 

 

The easiest way to create any type of chart is to use the Chart 

Wizard.  A òwizardó in Microsoft software is a small program 

within a program that helps you perform a task.  This one 

helps us to design and build charts.  All you need to do is: 

 

1. Select the data for the chart 

2. Press the òChart Wizardó button in the Standard toolbar 

 

 

 
The Standard toolbar 

 

This very simple example demonstrates how I made the pie 

chart on page 45.  It lists five different activities that 

managers spend their time on, adding up to a total of 50 

hours per week.  These managers are very interested to see 

how they are spending their time. 

 

 
Setup for example pie chart 

 

Note that I have already highlighted (selected) the range 

A3:B7.  This is the only data I need for my pie chart.  I was 

careful not to include the òtotaló in row 8, because it should 

not appear as a piece of the pie chart.  Now, I can activate the 

Chart Wizard. 

Chart Wizard 
 

TIP: 
You can also 
activate the Chart 
Wizard by selecting 
the data and then 
choosing ñChartéò 
from the Insert 
menu. 

COMMON 
MISTAKE: 
Donôt select too 
much data for your 
chart.  Totals, 
averages, and other 
summary statistics 
should not be 
included in your 
selection.  You may 
or may not need to 
select text labels, 
depending on the 
chart type. 














































































































